
Overview of BrainWave Generator
BrainWave Generator is a brain stimulation application that works by generating binaural beat 
frequencies. With binaural beats, you can stimulate your brain to make yourself relaxed, help in 
meditation or self-hypnosis, enhance learning capabilities, induce sleep, help focusing attention, and so 
on.

BrainWave generator can also produce flashes to further stimulate the brain via eyes. Combined, aural 
and visual stimulation result in more efficient brain wave entrainment.

For more information, click one of the following links.

Online resources in World Wide Web

Important warning

Brain states and frequencies

Entraining brain to a desired state with binaural beats

Effects of altered brain states

Technical details:

What are binaural beat frequencies?
What is modulation?
Available waveforms
Available background voices
Description of noise backgrounds
Visual on-screen flashing
Visual flashing with AudioStrobe



Online resources in World Wide Web
All BrainWave Generator online resources can be found at http://www.bwgen.com.

Following are shortcuts to some interesting areas.

Frequently Asked Questions: http://www.bwgen.com/faq
Latest news about BrainWave Generator: http://www.bwgen.com/news
Presets submitted by other BrainWave Generator users: http://www.bwgen.com/presets
The BrainWave Generator mailing list: http://www.bwgen.com/list



Important warning
Since BrainWave Generator uses flashes of high frequencies for external visual stimulation of the brain, 
the following people should not use BrainWave Generator in any case:

• People subject to any forms of seizures or epilepsy
• People using pacemakers
• People suffering from cardiac arrhythmia or other heart disorders
• People taking stimulants, psychoactive drugs, or tranquilizers

If you fall in any of these categories, do not use or even try BrainWave Generator!



Registering BrainWave Generator
BrainWave Generator is distributed as shareware. You can use it free for one month, after which you must
register. Registration costs $40 for a single-user license (for personal use only—for commercial and/or 
clinical license, please contact Noromaa Solutions). See also the BrainWave Generator License 
Agreement.

After registration, the following changes take effect immediately:

· The About window will not appear at startup anymore.
· The Import function in the File menu will be activated. For more information about the import 

functionality, click .

Ordering on-line by credit card
The easiest way to register BrainWave Generator is via RegSoft.COM. Their server uses secure 
transactions to guarantee the confidentiality of your credit card information. 

Other ordering options
To order by telephone, call RegSoft.COM at 1-877-REGSOFT (for international orders 770-497-9126). Be
sure to mention the product ID 8929.

Note
· Please do not use the above phone numbers for any other purposes than ordering. For 

technical support, questions about BrainWave Generator, etc. contact Noromaa Solutions 
directly.

You can also order by fax, by email or by regular mail (credit cards, checks and money-orders are all 
fine). For more information, see the RegSOFT.COM Web page.



Brain states and frequencies
EEG (electroencephalography) technology is used to measure brain's electrical vibrations from the 
surface of the scalp. The resulting EEG pattern will contain frequency elements mainly below 30Hz. The 
frequencies are categorized into four states as follows.

State Frequency State of mind
Delta 0.5–4Hz Deep sleep

Theta 4–8Hz Drowsy (also first 
stage of sleep)

Alpha 8–14Hz Relaxed but alert

Beta 14–30Hz Highly alert and 
focused

The dominant frequency in the brain's EEG pattern determines what shall be called the current state of 
the brain. If the amplitude of the alpha range frequencies is highest, then the brain is said to be in the 
alpha state. The purpose of BrainWave Generator is to affect the brain's state to achieve different results. 
For more information on how this is achieved, click . For more information on the possible results, click 

.
Note
· Brain's EEG pattern always consists of a wide range of different frequencies. The most dominant of 

them determines the current state of mind, but note that this is not any "exact frequency the brain is 
operating on". There are always also other frequency components present.



Entraining brain to a desired state with binaural beats
If external stimulus is applied to the brain, it becomes possible to entrain the brain frequency from one 
brain state to another. For example, if a person is in the beta state (highly alert) and a stimulus of 10Hz is 
applied to his/her brain for some time, the brain frequency is likely to change towards the applied 
stimulus. The effect will be relaxing to the person. This phenomenon is also called frequency following 
response.

When the brain's state is close to the applied stimulus, entrainment works more efficiently. Thus, when 
doing a sweep from one frequency to another, the starting frequency should be as close to the current 
brain state as possible. The sweep speed should be such that the brain's state changes steadily with it, so
that the difference never gets very large. In practice, it is difficult to determine the brain state without 
complex EEG measurement equipment. However, you can quite safely assume that during the day your 
brain is in the beta state (about 20Hz) and you can start a frequency sweep from there. If you are already 
somewhat relaxed, you can use a start frequency of 15Hz or a few Hz lower.

Stimulating the brain
The easiest way of applying stimulus to the brain is via ears and eyes. Since humans cannot hear sounds
low enough to be useful for brain stimulation, special techniques must be used. One such special 
technique used is called binaural beats.

If the left ear is presented with a steady tone of 495Hz and the right ear a steady tone of 505Hz, these 
two tones combine in the brain. The difference, 10Hz, is perceived by the brain and is a very effective 
stimulus for brainwave entrainment. This 10Hz is formed entirely by the brain. When using stereo 
headphones, the left and right sounds do not mix together until in your brain. The frequency difference, 
when perceived by brain this way, is called a binaural beat.

To get a stimulus of 10Hz, you may use tones of 495Hz and 505Hz, or 400Hz and 410Hz, or 862Hz and 
872Hz, or so on. The only requirements are that the tone is heard well enough and that it is below about 
1000Hz. Below 1000Hz, the wavelength of the sound is sufficiently small so that the sound waves curve 
around the skull.

Stimulating the brain with visual stimulus
Visual stimulation is easier than aural stimulation because low frequencies can readily be used. A 
frequency of 10Hz, for example, is generated when a led is flashed on and off 10 times a second in the 
front of your eyes.

When visual stimulus is in synch with aural stimulus, effects are highly increased over using only visual or
only aural stimulus.



Effects of altered brain states
Applying a stimulus to the brain will eventually bring the brain's state closer to the stimulus frequency. 
This topic describes some possible effects achievable by this.

Note
· Just passively listening to binaural beats does not necessarily alter your state of consciousness. For 

example, willingness and ability to relax and focus attention affects how effective the binaural beat 
stimulus is for inducing state changes.

Helping in meditation
Meditation is essentially about willingly being able to alter one's brain frequency to a desired state. While 
meditators have traditionally used several years to learn the techniques of meditation, you can now attain 
the same effect with brainwave entrainment. No special training or great discipline is required. Good 
meditation frequencies are in the alpha range, from 8Hz to 13Hz.

When a certain brainwave state is experienced and practiced over a period of time, the brain will "learn" 
the state change and it will become easier to self-produce the desired brainwave state at will. Thus, using 
brainwave entrainment, you can expect to get some of its effects later even without any external stimulus.

Reducing learning time
The theta state (4Hz–7Hz) has been found to increase learning capabilities. In fact, children spend more 
time in theta state than adults, which probably explains the accelerated learning capabilities of children.

Alpha frequencies are also useful for learning purposes. You can play language cassettes, subliminal 
tapes, etc. during an entrainment session for a maximum effect.

Reducing sleep needs
Some people have found that half an hour a day of the Theta state can replace up to 4 hours of sleep.

Treatment of certain mental diseases
Brainwave entrainment is used in treatment of depression, low self-esteem, attention deficit disorder, drug
and alcohol addiction and autism, to name a few.

Brainwave entrainment has also been found helpful in alleviating headaches and migraines.



How to use BrainWave Generator
This topic lists some tips for you to find the best way to use BrainWave Generator. Please note that the 
best practises are always up to your personal preference, and general guidelines are impossible to give.

· Use stereo headphones. Binaural beats are based on the fact that each ear hears a different sound.
· Adjust the volume to a comfortable level. If the sound starts to distract you, turn the volume down. The 

volume can be very low (even barely audible) and still have 100% effectiveness.
· Lie down. Use an extension cord so you can wear your headphones while lying on the bed. Be careful 

not to fall asleep! If you are familiar with different meditation positions, you may also try them.
· Some entrainment programs can be used while sitting at your computer and doing some work. Beta 

entrainment frequencies are best suited for this kind of use.



Binaural beat frequencies
For a general description of what binaural beats are and how they can be used to entrain brain state to a 
specific state, click .

BrainWave Generator generates sound output with different audible pitch frequencies for each ear. The 
frequencies generated by BrainWave generator are defined by two parameters (settable in the Preset 
Options dialog): Binaural Beat Frequency and Audible Pitch. The sound generated for the right ear is 
always Audible Pitch minus half of Binaural Beat Frequency. The sound generated for the left ear is 
Audible Pitch plus half of Binaural Beat Frequency. The average is effectively equal to the Audible Pitch 
value, and the difference is of course equal to the Binaural Beat Frequency value.
For example, consider the following settings:

Audible Pitch 450Hz
Binaural Beat Frequency 7Hz

These would result in the following frequencies generated by BrainWave Generator:

Right ear 446.5Hz
Left ear 453.5Hz



Modulation
Modulation is applied on top of the generated waveforms (see Binaural beat frequencies and 
Waveforms). You can configure the modulation depth (100% depth would cycle the output between full 
volume and zero volume) and the modulation frequency (expressed as modulation time).

The following illustration shows an output waveform (sine wave) with modulation applied to it. In this case,
the audible frequency is 500Hz, modulation depth is 50% and modulation time is 50 milliseconds 
(resulting in a frequency of 1000/50ms = 20Hz).

Modulation phase can also be set in BrainWave Generator. It affects the way left and right sound 
channels are modulated in relation to each other. If the phase is 0 degrees ("In phase"), both left and right
channels are modulated equally. If the phase is difference, the other channels "leads" in modulation. This 
will create a sensation of the sound circulating around your head.
Notes
· If you want modulation to play a part in brain stimulation, convert the modulation times to frequencies 

by dividing 1000 by the modulation time (for example, 1000/143ms    7.0Hz).
· In addition to sound output, modulation can also be applied to the background voice, background 

noise and visual output. Modulation for different voices (up to 10) in a preset can, of course, be 
specified separately.



Waveforms
You can set the basic waveform of the generated output on the Waveform tab of the Preset Options 
dialog. The selectable waveforms are illustrated below.

Waveform Waveform shape
Sine wave

Sine^2 wave

Sine^3 wave

Triangular wave

Rectangular 
wave

25% smoothed 
rectangular wave

50% smoothed 
rectangular wave

In addition to these predefined waveforms, you can also create you own waveforms. The waveform 
parameter is a special three-dimensional parameter. By normal dragging, you can change the Y value of 
the waveform. The Y value affects the curve flatness at the top of the waveform as follows:

Y value Waveform
0 Triangular wave

50 Sine wave

100 Rectangular wave

The Z value of the waveform parameter can be changed by holding down the CTRL key while dragging. It 
affects the curve sharpness at the top of the waveform as follows:

Z value Waveform
0 Sine^2 wave

50 Sine wave

100 Rectangular wave

By combining the different Y and Z values, you can also create other combinations.

You can further modify the waveform by applying filtering. For more information, click .

Note
· There is a waveform graph at the bottom of the Waveform tab in the Preset Options dialog. It shows 

the form of the output waveform without filtering taken into account. You can use the graph to test how 
changes to the Waveform parameter affect the appearance of the waveform.



Waveform filtering
You can filter the output waveform by specifying the Waveform Filter parameter in the Preset Options 
dialog.

You can set the filter cutoff frequency by modifying the Waveform Filter parameter. The cutoff frequency is
set in terms of harmonics above the current Audible Pitch frequency. Cutoff value of 0 corresponds to the 
current Audible Pitch frequency.

Waveforms that have sharp edges (like the rectangular waveform) cause strong harmonics in the output. 
This does not usually sound pleasing to the ear. Filtering can be used to reduce the amplitude of these 
higher unwanted harmonics.

Note
· There is a spectrum graph at the bottom of the Waveform tab in the Preset Options dialog. It shows 

the spectrum of the output waveform. Black bars show the spectrum without filterin, and blue bars 
show the spectrum with filtering taken into account.



Background voices
You can add backgrounds to your presets. Backgrounds can be voices (wave files) or noise, or a 
combination of both. For more information on background noise, click .

For information on background parameters (Background Phase Shift and Background Interval), click .
The available background voices are listed below. "Parametric" after the name means that the 
background parameter is available on the Background tab of the Preset Options dialog. Location shows 
the file in which the background is stored. For more information, see Installing new backgrounds. The 
cycle length (sample length) is shown in case you want to make use of it as a stimulation aid.

Background
Location Cycle 

length (s)

Animals: Baaing sheep 
(parametric)

Bgextra.dll One-time

Animals: Birds Bgextra.dll 3.414

Animals: Galloping horse Bgextra.dll 4.337

Animals: Howling dog (parametric) Bgextra.dll One-time

Animals: Mooing cow (parametric) Bkgnd.dll One-time

Animals: Pigeons Bgextra.dll 3.576

Animals: Seagulls Bkgnd.dll 4.477

Animals: Tropical birds Bgextra.dll 3.330

Nature: Babbling brook Bkgnd.dll 1.394

Nature: Gushing river Bgextra.dll 2.638

Nature: Heavy rain Bkgnd.dll 1.332

Nature: Night noises Bkgnd.dll 1.257

Nature: Roll of thunder (parametric) Bkgnd.dll One-time

Nature: Wind Bgextra.dll 4.627

Man-made: Chopping wood 
(parametric)

Bgextra.dll One-time

Man-made: Explosions 
(parametric)

Bgextra.dll One-time

Man-made: Traffic Bgextra.dll 4.344

Notes
· In addition to the backgrounds listed here, you can use your own wav files as backgrounds.
· You can apply modulation to any background. All three modulation parameters can be set for 

background modulation.



Background parameters
You can specify a background phase shift and background interval for most background voices. Both are 
specified on the Background tab of the Preset Options dialog.

The Background Phase Shift parameter sets a delay for the left or right background sound channel. 
Background shift has little effect on stereo backgrounds but it can make a mono background sound a lot 
different. Use positive values to have the right sound channel lead, and negative values to have the left 
sound channel lead.

The Background Interval parameter sets the repeating rate of some backgrounds. It is not available for 
most built-in backgrounds because they are continuous in nature. For example, the Babbling brook 
background is a short sound sample which sounds as a brook only because it is repeated over and over 
without gaps between the repeats.

For other types of backgrounds, you can specify a background interval. If set to 0 (or "Continuous"), the 
background is repeated over and over without gaps between the repeats. The value of the Background 
Interval parameter sets the number of seconds between the start of one repeat and the next repeat. 
Thus, it must be set higher than the background length to have any effect.



Noise backgrounds
In addition to background voices, you can add noise to your presets. Noise can be used to smooth the 
output of BrainWave Generator so that it will sound more natural.

You can set the background noise smoothness on the Background tab of the Preset Options dialog. A 
setting of 0% means rough white noise, 50% means softer pink noise and about 80–90% means very soft 
brown noise. The illustrations below show the noise waveforms resulting from some noise smoothness 
settings.

You can also set the noise source to be inside your head. However, this setting does not sound as natural
as having the source outside your head. If you use the "Noise source inside the head" setting, you should 
set the volume very low.
Notes
· The noise smoothness parameter does not change uniformly across the whole range 0%–100%. For 

example, a change from 0% to 10% is hardly noticeable, but a change from 80% to 90% is easily 
noticed.

· Due to the formula used for noise generation, higher smoothness settings produce noise with lower 
volumes. To maintain uniform noise volume, you will have to modify the background volume parameter
accordingly.

· You can apply modulation to the noise background. All three modulation parameters can be set for 
background noise. By using different modulation depth/period values with different noise 
smoothnesses, you can create some very interesting effects. For example, there are ocean wave 
types of backgrounds built-in into BrainWave Generator.



Visual on-screen flashing
BrainWave Generator can flash the computer screen at a desired frequency. This flashing can be used to 
enhance the brain wave entrainment effect. However, there are some severe limitations on using the 
computer screen for visual stimulation (see the bottom of this topic). To overcome these limitation, 
BrainWave Generator also supports AudioStrobe. See Visual flashing with AudioStrobe goggles.

You can set the visual flashing frequency on the Visual tab of the Preset Options dialog. You can also set
the brightness of the visual flashing, apply modulation, and specify a phase difference between the left 
and right eyes (only applicable to AudioStrobe flashing). Visual flashing is then turned on by selecting the 
desired flashing option from the Options menu before starting to play a preset: Flash Window, Flash 
Window (Always on Top) or Flash Full Screen.

The colors used while flashing the screen can be defined in the Visual Color Options dialog. There are 
two ways to get into this dialog.

1. Select Visual Color Options from the Options menu and deselect the "Override visual color options of
individual presets".

Then click the Preset options  button to modify the settings of the preset. On the General tab, 
click the Visual Color Options button.

2. Select Visual Color Options from the Options menu and select the "Override visual color options 
of individual presets".
Limitations
· The screen flashing frequency is not very precise. This is because the refresh rate of the computer 

monitor affects the precision of the on-screen flashing.
· When flashing the window, the colors may seem to change in the middle of the screen. This may 

distract the viewer. This problem can be solved by using full-screen flashing with DirectX. DirectX 
support can be turned on in the Advanced Options dialog.



Visual flashing with AudioStrobe goggles
BrainWave Generator can control goggle devices which support AudioStrobe. AudioStrobe compatible 
goggles are available from several sources. See http://www.bwgen.com/links for some providers.

AudioStrobe works by embedding control signals into the audio output. These signals have such high 
frequencies (19,200 Hz) that they are not heard by the human ear. Instead, they control the AudioStrobe 
goggle device to flash at specific rate and brightness.

You can set the visual flashing frequency on the Visual tab of the Preset Options dialog. You can also set
the brightness of the visual flashing, apply modulation, and specify a phase difference between the left 
and right eyes. Visual flashing through AudioStrobe is then turned on by selecting Use External Goggles 
(AudioStrobe) from the Options menu before starting to play a preset.

Known Problems
· The normal sound output of BrainWave Generator may interfere with the AudioStrobe control signals. 

This may happen if other than pure sine wave signals are used. You should use only the sine 
waveform when using AudioStrobe.



Starting and stopping an entrainment session
BrainWave Generator contains several built-in brainwave entrainment programs (presets). To start a 
session with one of them, follow the steps below.

1 Browse the Preset name list to find the preset you want to use.

2 Click the Play  button to start the output.
- or -

Click the Preset options  button to view and modify settings of the selected preset. For more 
information about modifying preset settings, click 

.

3 To stop playing the preset, click the Stop  button.

Note
· To get more information about a preset, click the Preset options  button and read the description of 

the preset.



Modifying parameters of a preset
To modify parameters of the currently selected preset, click the Preset options  button.

The parameters you can modify are listed below. For more information on the parameters, click the name 
of the parameter in the list.
Setting segment parameters (length and repeat count)
Setting voice parameters (binaural beat frequency, sound volume and audible pitch)
Specifying modulation of a preset
Selecting a background for preset

Changing parameter envelopes

Setting a parameter to track another parameter



Deleting unneeded presets
You can delete a preset that you do not need any longer by following the steps below.

1 Select the preset in the Preset name list.

2 Click the Delete preset  button.

Note
· Once you delete a preset, you can not get it back. However, you can get the built-in presets back by 

importing the file Default.bwg. For more information on importing presets, click .



Renaming a preset
You can change the name of a preset by following the steps below.

1 Select the preset whose name you want to change in the Preset name list.
2 Click the Preset options  button to modify the settings of the preset.

3 Enter a different name into the Name box on the General tab and click OK.

4 Click the Save  button to save the preset with the new name.

Note
· To save a copy of a preset to another name, select Save As from the File menu.



Importing presets
You can import a preset from an external bwg file by following the steps below.

1 Select Import from the Presets menu.
2 Select the bwg file you want to import. Bwg files can be created by exporting them from other 

installations of BrainWave Generator. For more information, click .

- or -
1 Double-click the bwg file you want to import in Windows Explorer. BrainWave Generator will 
open and import the file.
Notes
· Usually you import presets given to you by other people. For example, a friend of yours may have 

developed a preset which he or she wants to share with you. In this case, your friend would export 
his/her preset, transfer it to you via email, FTP, diskette or any other means. Then you would import 
that preset to be able to use it on your computer.

· There are presets available for download at http://www.bwgen.com (select the Presets link). You can 
also submit your own presets there.

· Importing presets is only available in the registered version of BrainWave Generator.



Exporting modified presets
You can export a preset you have modified by following the steps below.

1 Select the preset you want to export in the Preset name list.
2 Select Export from the Presets menu.
3 Specify the file into which you want to export the preset, and click Save.

Notes
· You can export presets into files for moving them to other computers or for distributing to other people. 

You can also make backups of your presets by exporting them. For instructions on how to import a 
preset back into BrainWave Generator, click .

· You can only export one preset into one file. However, BrainWave Generator stores all presets 
into the file Presets.bwg (including the built-in presets). If you want to move ALL of your presets to 
another computer, you can simply import the file Presets.bwg onto the other computer.



Saving output as a .WAV file
You can save the output of a preset to a .wav file by following the steps below.

1 Select the preset you want to save in the Preset name list.
2 Select Play into .WAV file from the Wave menu.
3 Specify options for the .WAV file, and click OK.
4 Specify the file into which you want to save the preset output, and click Save.

Notes
· If you want to store BrainWave Generator output onto a CD, you should select the Default CD settings 

checkbox. You will then have to use another software to process and convert the :WAV file for storing it
onto a CD.

· If you want to store BrainWave Generator output as an MP3 file, you must first save the desired output
as a .WAV file. You will then have to use another software to convert the :WAV file to MP3 format.



Creating new presets
You can create a new preset by following the steps below.

1 Click the New preset  button.
2 Modify the preset settings as desired and click OK.

3 Click the Save  button. If you did not enter a name in the Preset Options dialog, BrainWave 
Generator will ask you for the name of the new preset.

Note
· To create a preset with settings copied from another preset, select Save As from the File menu.



Setting segment parameters
Presets are divided into parts called segments. Each segment contains parameters which can be set 
independently of other segments. When playing a preset containing several segments, the segments are 
played one after another.

You can create a new segment into your preset by following the steps below.

1 Open the Preset Options   dialog   by clicking the  button. Select the General tab.
2 Click the Add button under the Segments section.
3 Enter an identification letter into the ID field. By default, segments are assigned letters A, B, C, 
etc.
4 Enter the length of the segment (in minutes) into the Length field. All other durations you set on 
other tabs of the Preset Options dialog will be relative to this length.

5 If you want to repeat this segment several times before moving to the next segment, enter the 
number of repeats into the Repeat field. For an example on how to create a preset with repeating 
segments, click .

6 Use the Move up and Move down buttons to change the order of your segments as desired.
7 Switch to the Output, Sound, and Background tabs to configure the parameters of the new 

segment in detail. For more information, click .

Notes
· When you have more than one segment in your preset, the tabs in the Preset Options dialog will 

show the segment whose settings they contain. You can easily change the segment to edit by pressing
Ctrl+Shift and the identification letter of the segment you want to edit.

· One preset may contain a maximum of 16 segments. Each segment may contain a maximum of 4 
voices, which can be different in each segment.



Setting voice parameters
Presets are divided into parts called segments. For more information on setting segment parameters, 
click . Each segment, in turn, may contain different voices which have parameters that can be set 
independently of other segments and voices. When playing a segment containing several voices, all the 
voices are played at the same time on top of each other.

You can create a new voice into a segment by following the steps below.
1 Open the Preset Options   dialog   by clicking the Preset options  button. Select the General tab.

2 Select the segment into which you want to create the voice, and click the Add button under the 
Voices section.

3 Switch to the Output and Sound tabs to configure the parameters in detail. For more information on 
configuring parameter envelopes, click . The parameters you can configure are listed below.

Parameter Description
Binaural Beat 
Frequency

Frequency of the 
generated binaural beats.

Sound Volume Output volume in percents.
100% is maximum volume 
and 0% mean no output.

Audible Pitch The frequency of the 
sound heard from 
earphones.

Modulation See Specifying modulation
of a preset.

4 Select the desired waveform of the output with the Waveform list-box on the bottom of the Sound 
tab. For graphical illustrations of the different waveforms, click .

Notes
· When you have more than one voice in a segment, the Output and Sound tabs in the Preset Options

dialog will show the number of the voice whose settings they contain. You can easily change the voice 
to edit by pressing Ctrl+Shift (or just Ctrl) and the number of the voice you want to edit.

· You can not change the order of the voices, because they are all played at the same time. Therefore, 
their order makes no difference.

· If the current segment has two voices, and the next segment has only one, the last node of the sound 
volume can't be moved. This is because the missing voice in the next segment means that its sound 
volume is essentially zero.



Selecting a background for preset
In addition to the binaural beat output of presets, they can also specify a background. The background 
may be one of the 19 build-in backgrounds, or an external wav file. The built-in backgrounds are divided 
into four categories: Nature, Animals, Man-made and Noise.

You can select a background for your preset by following the steps below.

1 Open the Preset Options   dialog   by clicking the Preset options  button. Select the General tab.
2 Select the desired built-in background from the Background list. To specify an external wav file, 
select Other... and select the wav file you want to use.
3 Switch to the Background tab to configure the envelope of the background volume. For more 
information on configuring parameter envelopes, click .

4 If you selected a built-in background voice which was designated as being parametric, you can also 
configure the envelope of that background parameter. The parameter varies depending on the 
selected background voice as shown in the list below.

Background Background parameter
Nature: Roll of 
thunder

Seconds between rolls of 
thunder

Animals: 
Mooing cow

Seconds between cow's 
moos

Animals: 
Baaing sheep

Seconds between sheep's 
baas

Animals: 
Howling dog

Seconds between dog's 
howls

Man-made: 
Explosions

Seconds between 
explosions

Man-made: 
Chopping wood

Seconds between chop 
sounds

Noise: Outside 
the head

Smoothness (or color) of 
the noise. 0% means 
rough white noise, 50% 
soft pink noise and about 
80% very soft brown noise.
100% smooth noise can 
not be heard.

The noise source is 
outside of your head.

For more information on 
background noise, click 
.

Noise: Inside 
the head

Same as above, but the 
noise will sound as if 
coming from inside of your 
head.

Notes
· If you use an external wav file as the background, be careful not to use too large files. BrainWave 

Generator converts all wav files to the output sample rate (set in the Advanced Options dialog) so if 
your wav file is 1MB with a 10kHz sample rate, it will consume 4MB of memory if BrainWave 
Generator's sample rate is set to 40kHz.

· You can only specify one background for a preset. Background can not be changed between 



segments of a preset.



Specifying modulation of a preset
The steady sound output of BrainWave Generator may sound somewhat boring as such. You can make it 
more "lively" by adding some modulation to it. For more information on modulation, click .

You can specify modulation for your preset by following the steps below.
1 Open the Preset Options   dialog   by clicking the Preset options  button. Select the voice you 

want to modify on the General tab, and switch to the Sound tab.
2 Specify modulation by setting the Modulation Depth parameter envelope. For more information on
configuring parameter envelopes, click . A modulation depth of 0% means that no modulation is in 
effect. A depth of 100% means that the output will cycle periodically between full output volume (as set by 
the Sound Volume parameter on the Output tab) and zero volume.

3 Specify modulation period by setting the Modulation Period parameter envelope. Modulation period 
indicates the time (in milliseconds) between the full output volume peaks. For a graphical illustration 
of this effect, click .

4 Check the Circular modulation check-box if you want the modulation to be circular. Circular 
modulation means that the modulation of the left and right sounds are 180° apart, thus creating an 
illusion of the sound circling around your head.



Changing parameter envelopes
All parameters of BrainWave Generator (binaural beat frequency, sound volume, audible pitch, 
modulation and background) have associated envelopes. An envelope lets you specify the value of the 
parameter as a function of time.

The steps below show an example of how to modify different aspects of an envelope.

1 Open the Preset Options   dialog   by clicking the Preset options  button. Switch to the tab 
containing the parameter you want to modify.

2 Click between two existing nodes to select the line between them.
3 Click the right mouse button on the line, and select Insert New Node. Drag the new node to the 
position you want.

4 Click and drag one of the node's weight handles (small red boxes) to change how the line between 
the two nodes should go. Note, that all lines change their shape, because all nodes are symmetric 
by default. To make a node non-symmetric, right-click it and deselect the Symmetric option. When 
you now drag the weight handles, the lines beyond the non-symmetric node will not change.

Note
· The time scale on the x axis is the length of the current segment. This length can be set on the 

General tab of the Preset Options dialog. For more information on setting segment parameters, click
.



Setting a parameter to track another parameter
Instead of specifying all 7 parameters of a preset separately, you can set some of them to track others. 
For example, you may want the modulation period to depend on the binaural beat frequency so that with 
low values of binaural beat frequency, the modulation period will be long and for high values it will be 
short.

You can set this kind of tracking by following the steps below.

1 Open the Preset Options dialog by clicking the Preset options  button. Switch to the Sound tab.
2 Check the Track another parameter check-box above the Modulation Period parameter. A list-
box with all parameters appears.
3 Select the parameter you want the modulation period to track from the list-box. In this case you 
select Binaural Beat Frequency.
4 Click the Parameters  button.

5 Specify the following parameters in the Tracking Options dialog:
When Binaural Beat Frequency changes from 15.00 to 5.00
Change Modulation Period from 50 to 2000.

6 Switch to the Output tab, modify the binaural beat frequency envelope and note how the modulation 
period parameter changes accordingly. For more information on configuring parameter envelopes, 
click .

Note
· If you have several voices in your preset, voice parameters can only be set to track other voice 

parameter in the same voice. Other parameters (like background volume) track voice parameters of 
the currently selected voice.



Creating a preset with a fadeout at the end
You can create a preset which gently fades out at the end by following the steps below.

1 Click the New preset  button to create a new preset.
2 Specify any parameters you want for the binaural beat frequency, sound volume, audible pitch, 
modulation and background.
3 Modify the sound volume parameter so that it stays near 100% in the beginning of the preset, but 
at a certain point drops down to 0%. Specify a weight less than 50% to make the fadeout start slower and 
accelerate towards end. The sound volume envelope might look as follows:

4 Click OK to close the Preset Options dialog.

5 Click the Save  button and enter a name for your new preset.

Note
· When the sound volume of a preset is zero at the end, sound output will automatically end when the 

preset has played.



Creating a preset with steady audible pitch
You can create a preset in which the binaural beat frequency changes, but the audible pitch stays the 
same. This way you won't notice the change as actively as you do if the audible pitch also changes. You 
can do this by following the steps below.

1 Click the New preset  button to create a new preset.
2 Specify any parameters you want for the binaural beat frequency, sound volume, audible pitch, 
modulation and background.

3 Modify the audible pitch parameter so that it is equal for the whole duration of the preset segment. 
The binaural beat frequency and audible pitch envelopes might look as follows:

4 Click OK to close the Preset Options dialog.
5 Click the Save  button and enter a name for your new preset.

Note
· You can also experiment with an increasing audible frequency while the binaural frequency decreases.

This creates a confusing effect as the brain would assume the binaural frequency to increase based 
on the audible pitch.



Creating a preset with repeating segments
You can create a preset which repeats a certain pattern several times by following the steps below.

1 Click the New preset  button to create a new preset.
2 On the General tab, enter a number greater than 1 in the Repeat box. Modify the parameters of 
the segment as desired. When played, this segment will be repeated the number of times specified by the
Repeat setting.
3 Add a new segment to the preset and modify its parameter so that it acts as the end of your 
preset. The end segment is not required, but normally you want to fade out the output after the repeating 
segment, or leave it playing at some different rate than at the end of the repeating segment.

4 Click OK to close the Preset Options dialog.
5 Click the Save  button and enter a name for your new preset.

Note
· The end node of a segment and the start node of the succeeding segment are always equal. For 

repeating segments, the end node is equal to the start node. When changing the start or the end node,
the other node will move accordingly.



Creating a complex preset with several stimulation options
This topic demonstrates how you can create a preset with several ways to stimulate the brain. Note, that 
this preset will probably be useless as such, so you should use only some of these techniques in a single 
preset.

1 Click the New preset  button to create a new preset.
2 Set the binaural beat frequency to a constant of 10Hz. This is the basic way of stimulating the 
brain with a frequency of 10Hz.
3 Add more voices and set their binaural beat frequencies as desired. This way you can have up to 
4 independent brain stimulation frequencies.
4 Set the modulation depth to 50–100% and modulation period to 500Hz. This will add a stimulation
effect of 2Hz (=1000/500ms) to any voice.

5 Select a parametric background on the General tab (for example, baaing sheep). Then set an 
interval of 10s for the baas on the Background tab. This will add a stimulation effect of 0.1Hz 
(=1/10s).

6 Select a continuous background on the General tab (for example, babbling brook). Check the length 
of the background cycle to determine the stimulation effect. In this case, it would be 0.717Hz 
(=1/1.394s).

7 Create a repeating segment and modify any envelope(s) to include a desired stimulation effect. 
Since the minimum repeat time is 1 minute, you may have to create the envelope(s) so that they 
repeat the desired shape several times. For example, with a 1 minute repeat setting, you can get a 
stimulation effect of 0.1667Hz (=1/6s) with the following envelope:

Notes
· Simultaneous voices of different audible frequencies may mask each other out quite effectively. Make 

sure to experiment with different volumes for the voices for the best effect.
· Complex stimulation options usually help in alleviating headaches and migraines, so you might want to

experiment with several stimulation options in one preset.
· One nice stimulation effect is to keep the binaural beat frequency constant and only change the 

audible pitch frequency. The illustration above is taken from one such preset.



Resetting default presets
If you have inadvertly modified and saved built-in presets of BrainWave Generator, you can reset them by
following the steps below.

1 Select Import from the Presets menu in BrainWave Generator.
2 Select the file Default.bwg and answer Yes when asked whether you want to overwrite the existing 

presets. For more information on importing presets, click .

- or -

1 In Windows Explorer, open the folder into which you have installed BrainWave Generator (by 
default, this is C:\Bwgen).

2 Delete the file Presets.bwg. When BrainWave Generator is restarted, it will create a new 
Presets.bwg file containing the default presets.

Note
· Importing presets is only available in the registered version of BrainWave Generator.



Improving sound quality and/or improving performance
Sometimes BrainWave Generator output sound quality may not be high enough, there may be gaps in the
sound output, or BrainWave Generator may use too much processor time. There are several options 
which affect this kind of behavior (for more information, click  ), but if you do not know how to optimize 
them, follow the steps below.

1 Create a new preset for testing purposes. This preset must be as simple as possible (one voice, no 
background, no modulation). You can create this kind of preset by clicking the New preset  
button.

2 Select Advanced Options from the Options menu. Enter the following settings:
Samples per second = 44100
Bits per sample = 8
Number of memory blocks = 2
Length of memory blocks = 200

3 If the output quality is not satisfactory, try varying the Samples per second value in the range 
30000–50000.

4 If there is too much noise in the output, try using 16 bits per sample instead of 8.
5 If there are gaps in the sound output, first try increasing the Number of memory blocks to 4, and if 

it does not help, up to 8. At the same time, try increasing the Length of memory blocks up to about 
500.

Notes
· Some newer sound cards may have features that somehow "enhance" the sound output. For best 

results with BrainWave Generator, you should turn all such features off. This includes features like 
bass boost, 3D sound, bass/treble adjustments etc.

· If you are going to run other applications at the same time with BrainWave Generator, do that at the 
time when optimizing the output. Other applications affect the performance of BrainWave Generator 
(and vice versa).

· The complexity of presets affects the performance of BrainWave Generator. Voices, modulation, 
background and background parameter all contribute to the processing power required to play a 
preset.



Installing new backgrounds
BrainWave Generator backgrounds are stored as DLL files. To install new backgrounds, follow the steps 
below:

1 Close BrainWave Generator.
2 Use Windows Explorer to copy the new background DLL file into the same directory with 

BrainWave Generator. By default, this directory is C:\Bwgen.
3 Restart BrainWave Generator. You should now have backgrounds from the new DLL shown in the 

Background dropdown in the Preset Options   dialog.  
Note
· The standard backgrounds provided with BrainWave Generator are contained in Bkgnd.dll. The extra 

backgrounds provided with BrainWave Generator are contained in Bgextra.dll.



Configuring AudioStrobe output
AudioStrobe devices are controlled by signals embedded into the output sound (for more information, see
Visual flashing with AudioStrobe goggles). Use the following procedure to configure your AudioStrobe 
goggles to work optimally for you.

1 Select Configuration Wizard from the Options menu. Click Next four times to get to the Check 
AudioStrobe output screen.

2 Connect your goggles to the computer sound system, and click the Test AudioStrobe button. The 
LED's on your goggles should start blinking.

3 Check the "I have an AudioStrobe device attached to my sound system" checkbox, and click Next.
4 On the Configure AudioStrobe output 1/2 page, click the Start Testing button, and observe how the 

lights on your goggles blink. Adjust the maximum brightness level to a value that is enough to light 
the LED's to their maximum brightness. Note that the actual brightness of the LED's during a session
is set by the corresponding preset's Visual Brightness parameter. When finished, click the Next 
button.

5 On the Configure AudioStrobe output 2/2 page, click the Start Testing button, and observe how the 
lights on your goggles blink. Adjust the brightness zero level so that the blinking looks good. The 
brightness zero level should be set so that it is the maximum possible value with which the LED's are
still off. You can test the current value without any blinking by clicking the Test Zero Level button. 
The LED's on your AudioStrobe goggles should remain off while the Zero Level test is running.

Notes
· You can also configure your sound system for AudioStrobe by keeping the maximum and minimum 

levels constant, and adjusting the sound volume instead.
· The AudioStrobe zero level cannot be set higher than the AudioStrobe maximum level. If it is, the 

LED's will always stay on at a constant brightness, no matter what the value of Visual Brightness 
parameter is.



Preset Options Dialog
In the Preset Options dialog, you can configure all settings of a preset. The tabs of this dialog are 
described below. For more information on the options and parameters on each tab, click the  button in 
the top-right corner of the dialog, and click the option/parameter on which you want more information.

General
Settings on this tab specify options for the whole preset. This includes the name, description, 
background, segments, and voices in each segment.

Sound
This tab contains the most important output parameters of one voice: binaural beat frequency, 
audible pitch and sound volume. 

Waveform
This tab contains the waveform setting of one voice.

Background
This tab contains options for the background of the preset. This includes background volume, phase 
shift and possible a background parameter, depending on background selected on the General tab.

Noise
In addition to a normal background, presets can contain noise as their background. This tab contains
options for noise background of the preset. 

Visual
If you want to use visual flashing as part of the brain wave entrainment session, use the settings on 
this tab. For more information on visual flashing options, see Visual on-screen flashing.



Modulation Dialog
In the Modulation dialog, you can configure modulation parameters. For more information on a specific 
modulation parameter, click the  button in the top-right corner of the dialog, and click the parameter on 
which you want more information.



Sweep Parameters Dialog
In the Sweep Parameters dialog, you can set the parameters of two nodes in a parameter envelope. For 
more information on configuring parameter envelopes, click . Note that you can set all of these options 
directly in the Preset Options dialog by using mouse and right-click menus.

<parameter>
Sets the range of the parameter values. The parameter may be binaural beat frequency, sound 
volume, etc. The start value represents the node you have selected, and the end value represents 
the next node.

Constant
Check this check-box if you want the end value to be the same as the start value.

Sweep time
Sets the times of the start node and the end node.

Sweep weight
Sets the shape of the curve by which the start node value changes to the end node value. Use 
values 0–100 where 50 means a linear change.

Linear sweep
Check this check-box if you want the start node value to change linearly to the end node value. This 
is the same as setting Sweep weight to 50.

Symmetric node
Check this check-box if you want the weight value of the next node to be automatically changed to 
be the same as the weight of this node. By using symmetric nodes, it will be easier to create your 
parameter envelope so that there are no too steep changes in it.

Note
· Note that you can change the values of two nodes in this dialog. The "from" values are those of the 

selected node, and the "to" values are those of the next node. You can change them both.



Tracking Options Dialog
In the Tracking Options dialog, you can set the parameters which affect how the selected parameter 
tracks another parameter. There are two ways of specifying the tracking formula. The easiest one is to 
select the Specify change ranges option and set the following two pairs of from/to values.

When <tracked parameter> changes from/to
These from/to values specify the "base" range of the tracked parameter.

Change <tracking parameter> from/to
These from/to values specify what the corresponding change in the tracking parameter will be.

The other way of specifying the tracking formula is by entering Y intercept and Y/X slope values directly. 
The value of the tracked parameter is calculated with the following formula: P2=a+b*P1 where a is the 
value of Y intercept and b is the value of Y/X slope. This method is only recommended if you understand
the preceding description.

You can also specify limits for the tracking parameter. If the calculated tracking value would be out of the 
min/max limits, the minimum/maximum value will be used instead.



Visual Color Options Dialog
In the Visual Color Options dialog you can specify the used for visual screen flashing. For more 
information on visual flashing options, see Visual on-screen flashing. The fields in this dialog are 
described below.

Override visual color options of individual presets
If checked, visual color options set for preset have no effect. Instead, the options set in this dialog 
are always used. This checkbox is only visible if you selected Visual Color Options from the Options 
menu. It will not be visible if the Visual Color Options button was clicked in the Preset Options dialog.

Colors
Specifies the colors which are flashed in sequence when visual flashing is on. Use the Modify 
Color, Add and Delete buttons to modify the colors. Use the Move up and Move down buttons to 
change the order of the colors.



Advanced Options Dialog
In the Advanced Options dialog you can specify options related to the sound output quality, memory 
usage of BrainWave Generator and visual flashing. The fields in this dialog are described below.

Samples per second
Specifies the output sample rate of BrainWave Generator. The higher the sample rate, the better the 
output quality. For example, CD-quality sound uses 44100 samples per second, which is the default 
setting.

Bits per sample
Specifies the depth of each output sample. 16-bit sound has much less noise than 8-bit sound. The 
default is 16 bits.

Number of memory blocks
Specifies the amount of internal output buffers used by BrainWave Generator. The higher this 
number, the more output BrainWave Generator can buffer, thus being able to tolerate higher loads 
on the computer without gaps in the output. The default is 4.

Length of memory blocks
Specifies the length of output buffers in milliseconds. Effects are same as above, but longer buffer 
lengths may slow down the computer because they take longer to fill. The default is 200 
milliseconds.

Memory consumed
Shows the amount of memory consumed with the options set in this dialog.

Invert left and right sound channels
If checked, swaps the left and right sound channels.

Use DirectX for smooth full-screen flashing
If checked, BrainWave Generator uses DirectX for visual flashing of the screen. If this check-box is 
grayed, you do not have DirectX installed. For more information on visual flashing options, see 
Visual on-screen flashing.

AudioStrobe brightness zero level
Sets the zero-level of AudioStrobe lights when visual flashing with an AudioStrobe device is used. 
For more information on configuring your AudioStrobe compatible device, see Configuring 
AudioStrobe output.

AudioStrobe maximum brightness level
Sets the maximum level of AudioStrobe lights when visual flashing with an AudioStrobe device is 
used. For more information on configuring your AudioStrobe compatible device, see Configuring 
AudioStrobe output.

Number of nodes in a new parameter
Sets whether parameters of a new preset will have 2 or 3 nodes after being created. This affects 
creation of new presets, as well as adding segments and voices to existing presets. 

Link adjacent segments automatically together in Preset Options
If checked, the Preset Options dialog will make sure that the end node of a segment is always the 
same as the start node of the next segment. If not checked, this rule is not applied. Note that in this 
case presets can easily have unwanted "bumps" (abrupt parameter value changes).

Notes
· To maximize the sound quality, use 16-bit sound with a sample rate of 44100.
· To minimize unwanted gaps in the output when your computer runs other applications as well, use as 

many memory blocks as possible and as long memory blocks as possible.
· Following the above two points will lead to high memory usage, which will in turn decrease 

performance. Experiment with different settings to find the optimum. For more information, click .
· The length of memory blocks set the minimum change rate of the output parameters. If you have a 

rapidly changing parameter (for example, an audible frequency sweep from 10,000Hz to 100Hz), you 



will have to decrease the length of memory blocks to make the change sound natural enough.



Preset
Preset is a set of parameters which define a brain entrainment session. There are several built-in presets 
included with BrainWave generator, and you can also create your own presets.



Segment
Segment is a building block of a preset. A preset may contain just one segment, or several segments. 
Segments are played one after each other in the preset. Segments may contain one or more voices.



Voice
Voice is a building block of a segment. All voices play simultaneously in one segment, so their order is of 
no importance.



Waveform
Waveform denotes the format of the sound output. The most basic waveform is a sine wave, which 
produces a pure one-frequency output. Other waveforms (sine^2, triangular, rectangular and smoothed 
rectangular waveforms) introduce harmonic frequencies into the output. For more information on how to 
set your own waveform, click .



Envelope
Envelope means the set of output parameters as a function of time. The output parameters may change 
any way you like as time goes on. For example, you can define the binaural beat frequency to start at 
15Hz, then descend to 5Hz during 8 minutes, and last increase to 7Hz during the last 2 minutes. The 
resulting curve is called the binaural beat frequency envelope.



Binaural beat
If a steady tone of 395Hz is applied to your left ear, and a steady tone of 405Hz to your right ear, the 
difference, 10Hz, will be perceived by your brain. Since inaudibly low frequencies (like 10Hz) are required 
for brain stimulation, binaural beats are the way of applying such stimulus.

For more information, click .



Brain stimulation
Brain stimulation is a way of altering your state of consciousness. BrainWave Generator uses binaural 
beat frequencies for brain stimulation.

For more information on brain states, click .

For more information on brain stimulation, click .



Harmonic
Harmonic (short for harmonic frequency) is a multiple of a base frequency. For example, if the base 
frequency (Audible Pitch) is 440 Hz, the first harmonic is 880 Hz, the second harmonic is 1320 Hz, the 
fourth harmonic is 1760 Hz, and so on.



The New Preset command creates a new preset. After having changed the desired options, use the Save
command to save the preset. For more information on creating new presets, click .



The Save command saves the modified preset.



The Save As command saves the modified preset with a different name.



The Delete command deletes the currently selected preset. For more information on deleting presets, 
click .



The Export command exports the currently selected preset to a file. For more information on exporting 
presets, click .



The Import command imports an external preset file into BrainWave Generator. For more information on 
importing presets, click .



The Exit command quits BrainWave Generator.



The No Visual Effects setting specifies not to use any visual flashing. For more information on visual 
flashing options, see Visual on-screen flashing.



The Use External Goggles (AudioStrobe) setting specifies to use an external AudioStrobe compatible 
device for visual stimulation. For more information on visual flashing options, see Visual on-screen 
flashing.



The Flash Window settings specifies to flash the BrainWave Generator window for a visual stimulation 
effect. For more information on visual flashing options, see Visual on-screen flashing.



The Flash Window (Always on Top) settings specifies to flash the BrainWave Generator window for a 
visual stimulation effect. The window will remain on top of all other windows on the screen. For more 
information on visual flashing options, see Visual on-screen flashing.



The Flash Full Screen setting specifies to flash the entire screen for a visual stimulation effect. For more 
information on visual flashing options, see Visual on-screen flashing.



The Visual Color Options command brings up the Visual Color Options dialog for setting options of 
screen flashing stimulation. For more information on visual flashing options, see Visual on-screen 
flashing.



When the Show Parameters While Playing option is enabled, the sound volume and frequency are 
shown in the BrainWave Generator window. With this option disabled, the parameters are not shown in 
the window.



The Configuration Wizard command opens the BrainWave Generator Configuration Wizard which 
allows you to set up your sound system for optimal performance.



The Advanced Options command brings up the Advanced Options dialog.



The Play command starts playing the currently selected preset.



The Play With Delay command waits a specified number of minutes and then starts playing the currently 
selected preset. This command can be used to allow you to get comfortably situated before starting 
playback.



The Stop command stops playing the currently playing preset.



The Freeze/Restart command freezes the currently playing preset so that its parameters don't change. If 
already frozen, this command restarts advancing all parameters as defined by the preset.



The Play into .wav file command starts playing the currently selected presets, but instead of playing it 
through the computer sound system, BrainWave Generator will save the output to a file. For more 
information on playing BrainWave Generator output to a file, see Saving output as a .WAV file.



The Preset Options command lets you modify parameters of the currently selected preset. For more 
information, click .



The Help Topics command shows the BrainWave Generator Help.



The About command shows generic information about BrainWave Generator.



The Edit command opens the Sweep Parameters dialog where you can specify parameters for the 
selected node.



The Delete command deletes the currently selected node from the parameter envelope.



The Insert command inserts a new node after the selected node into the parameter envelope.



The Symmetric command lets you toggle the selected node between symmetric and non-symmetric. For 
symmetric nodes, the weights on both sides of the node are always made equal.



The Play Here command starts playing the current preset at the position pointed to by the mouse. As 
opposed to normal playback, the playing position does not advance in time. You can make changes to 
the preset and get immediate feedback of how the changes affect the output.



The Stop Playing command stops the playing of the current preset.



The Refresh Minimum and Maximum command refreshes the Y axis range. If you have changed the 
parameter envelope values so that the range is wider than necessary, you can use this command to reset
the range to the minimum possible range.



Specifies the output sample rate of BrainWave Generator. The higher the sample rate, the better the 
output quality. For example, CD-quality sound uses 44100 samples per second.



Specifies the depth of each output sample. 16-bit sound has much less noise than 8-bit sound.



Specifies the number of memory blocks BrainWave Generator will use when generating sound output. For
more information, click .



Specifies the length of each memory block BrainWave Generator will use when generating sound output. 
For more information, click .



If checked, swaps the left and right sound channels.



If checked, BrainWave Generator uses DirectX for visual flashing of the screen. If this check-box is 
grayed, you do not have DirectX installed. For more information on visual flashing options, see Visual on-
screen flashing



Sets the zero-level of AudioStrobe lights when visual flashing with an AudioStrobe device is used. For 
more information on configuring your AudioStrobe compatible device, see Configuring AudioStrobe 
output.



Sets the maximum level of AudioStrobe lights when visual flashing with an AudioStrobe device is used. 
For more information on configuring your AudioStrobe compatible device, see Configuring AudioStrobe 
output.



If checked, the Preset Options dialog will make sure that the end node of a segment is always the same 
as the start node of the next segment. If not checked, this rule is not applied. Note that in this case 
presets can easily have unwanted "bumps" (abrupt parameter value changes).



Sets whether parameters of a new preset will have 2 or 3 nodes after being created. This affects creation 
of new presets, as well as adding segments and voices to existing presets.



Specifies the name of this preset.



Specifies a textual description of this preset.



Specifies the background of this preset. Select Other... to specify a separate sound file.



Lists the segments in this preset.



Lists the voices in this segment.



Specifies the identifier of this segment. The identifier should be a letter A–Z in which case you can change
to this segment easily by pressing the ID letter with CTRL and SHIFT depressed.



With these buttons, you can reorder the segments into the desired order.



Specifies the length (in minutes) of this segment.



Specifies the number of times this segment will be repeated.



Adds a new segment into the preset.



Deletes the current segment from the preset.



Adds a new voice into the preset segment.



Deletes the selected voice from the preset segment.



Opens the Visual Color Options dialog for setting options of screen flashing stimulation. These options 
are used only when playing this preset. For more information on visual flashing options, see Visual on-
screen flashing.



If checked, this preset will continue playing even after all the segments have been played (with the last 
parameters). If not checked, playback will stop after the last segment.



Starts playing the current preset from the beginning. As opposed to normal playback, the playing position 
does not advance in time. You can make changes to the preset and get immediate feedback of how the 
changes affect the output.



The Binaural Beat Frequency parameter sets the difference between the sound output of the left and right
ear. For more information on binaural beat frequencies, click .



The Audible Pitch parameter sets the pitch of the audible sound heard from the headphones. The exact 
pitch for the right ear is Audible Pitch minus Binaural Beat Frequency divided by 2, and the pitch for the 
left ear is Audible Pitch plus Binaural Beat Frequency divided by 2. For example, Audible Pitch 400Hz and
Binaraul Beat Frequency of 10Hz yield 395Hz for the right ear and 405Hz for the left ear.



The Sound Volume parameter sets the volume of the sound output. 100% means the maximum volume 
as set in your sound system volume settings.



The Waveform parameter sets the output waveform. This parameter employs a special 3-D chart for 
setting the waveform between sine wave, triangular wave, rectangular wave and sine^2/sine^3 wave.



The Waveform Filter parameter adjust the output waveform by cutting off frequencies above a specified 
frequency. Cutoff frequency is specified in terms of harmonics above the current Audible Pitch frequency. 



Non-existent parameter.



The Background Volume parameter sets the volume of the background voice. If None has been selected 
for background (on the General tab), this parameter has no effect. For more information on backgrounds, 
click .



The Background Shift parameter sets a delay for the left or right background sound channel. Background 
shift has little effect on stereo backgrounds but it can make a mono background sound a lot different. Use 
positive values to have the right sound channel lead, and negative values to have the left sound channel 
lead.



The Background Parameter depends on the selected background voice. If a non-parametric background 
has been selected, it is not is use. If a parametric background has been selected, it reflects the parameter
settable for that background. For more information on backgrounds, click .



The Noise Volume parameter sets the volume of the noise background. 100% means the maximum 
volume.



The Noise Smoothness parameter sets the smoothness of the background noise. Smoothness of 0% 
means rough white noise, 50% means softer pink noise, and about 80–90% means very soft brown noise.



Non-existent parameter.



The Visual Frequency parameter sets the frequency of visual flashing (either on-screen or via 
AudioStrobe). For more information on visual flashing options, see Visual on-screen flashing.



The Visual Brightness parameter sets the brightness of the visual flashing (either on-screen or via 
AudioStrobe). With on-screen flashing, reduced brightness means darker colors. For more information on 
visual flashing options, see Visual on-screen flashing.



The Visual PhaseDifference parameter sets the relation of the left visual channel to the right channel. 
Since on-screen flashing only has one channel, this parameter has no effect when used with on-screen 
flashing. This parameter is only supported with AudioStrobe output. For more information on visual 
flashing options, see Visual on-screen flashing.



Specifies whether this parameter tracks another parameter or is specified independent of other 
parameters.



Specifies which parameter this parameter tracks, i.e. which parameter the envelope of this parameter is 
based on.



Click this button to change the options by which this parameter tracks another parameter.



Click this button to change the modulation options related to this item. Modulation means changing the 
volume periodically between two values. A simple sound can often be made much richer and more 
complex by using some modulation.



Use these radiobuttons to toggle the graph below to show the value of either the left or right channel.



If this checkbox is selected, you can specify the parameter values separately for the left and right 
channels. When checked, you can use the Left/Right radiobuttons to toggle the chart display between the 
left and right channel.



Use this slider to set the position at which the waveform and spectrum will be shown.



Shows the waveform set by the Waveform and Waveform Filter parameters. The first bar in the spectrum 
graph is the base frequency (Audible Pitch). The black bars show the spectrum without filtering and the 
blue graphs show the resulting spectrum after filtering has been applied.



Select this check to make the left and right noise channels inverse of each other. This will create an 
illusion as if the noise were coming from inside your head. Otherwise it will sound as if coming from 
outside of the head. Note that having the noise source inside the head is usually not as pleasant as 
having it outside.

This checkbox is disabled if you have chosen to specify the noise smoothess separately for left and right 
ear.



The Modulation Depth parameter sets how deep the volume (or brightness) will be modulated. 0% means
no modulation and 100% means that the output will cycle between the full value (as set by the volume or 
brightness parameter) and zero. For more information about modulation, click .



The Modulation Period parameter sets the time between two successive modulation peaks. This 
parameter has no effect if modulation is not in use (Modulation Depth is zero). For more information on 
modulation, click .



The Modulation Phase parameter set the relation of the modulation applied to the left channel and the 
right channel. Phase of 0 degrees means that modulation occurs is applied to both channels at the same 
time. Phase of 90 degrees means that the left channel leads by one fourth in modulation, and 180 
degrees means that modulation is exactly oppisite for each channel. For more information on modulation, 
click .



Specifies the start value of the node you are modifying.



Specifies the end value of the node you are modifying.



Specifies the Z component of the start value of the node you are modifying. For more information on 
specifying the waveform parameter in the XYZ-coordinate system, see Waveforms.



Specifies the Z component of the end value of the node you are modifying. For more information on 
specifying the waveform parameter in the XYZ-coordinate system, see Waveforms.



Select this check-box if you want the end value to be the same as the start value.



Specifies the start time of the node you are modifying.



Specifies the end time of the node you are modifying. This is equal to the start time of the next node.



Specifies the sweep weight of the node you modifying. If the node has been set as symmetric, this may 
also affect weights of other nodes.



Specifies whether the node you are modifying is symmetric or non-symmetric. For symmetric nodes, the 
weights on both sides of the node are always made equal.



Select this check-box to make the sweep weight fixed at 50%.



These edit-boxes specify how the tracked parameter is mapped to the current parameter. The mapping is 
specified by selecting how the current parameter will change when the tracked parameter changes. For 
more information, click .



Select this button to specify tracking options by entering change ranges. For more information, click .



Select this button to specify tracking options by entering a and b parameters directly. For more 
information, click .



Specifies the a parameter of the tracking options. For more information, click .



Specifies the b parameter of the tracking options. For more information, click .



Specifies limits for the current tracking parameter. If a value calculated by the tracking options would 
exceed these limits, it is set to the limiting value.



If checked, visual color options set for individual presets have no effect. Instead, the options set in this 
dialog are always used.



Specifies the colors which are flashed in sequence when visual flashing is on.



Changes the selected color.



Adds a new color to the list.



Deletes the selected color from the list.



Moves the selected color up or down in the list.




